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Tutorial: High-quality digitizing of analogue VHS video cassettes (also S-VHS, Video8, Hi8, VCR, etc.)

foreword

What this is about:
This guide is about video recordings of old (S-) VHS video tapes and other formats to high-quality, standard-compliant and synchronized to digitize
digital video files that can replace the original and u. U. even better. It does not matter if it is about camera shots, TV programs or even original
films.

What is it about video tapes in general? 
Analog video tapes such as (S-) VHS, V8, Hi8, etc. store analog (TV) video signals in PAL / NTSC / SECAM format and a corresponding audio
signal. 
In principle, they are magnetic tape "streamers" which can store and reproduce these signals magnetically in a specially converted form.
So there is always a video signal recorded on the tapes. This may have been produced by cameras, a TV transmitter, receiver or DVD player, or by
another video player that has copied a tape, for example. During playback, the originally recorded video signal is reproduced by the player as well
as possible. Both system-dependent and device-dependent losses occur during recording as well as during playback, some of which are even
intended for format reasons (eg reduced bandwidth for storage). This manifests itself in the fact that the image of the band in comparison to the
original signal is usually much blurred, shows more noise, has shifted colors and is generally more unstable.

What is a video signal? 
Analog video signals are originally from the era of tube TVs. A signal has been generated which, line by line, transmits in the form of voltage
values the image information that can be directly displayed by a CRT monitor.
At the time of black and white television, only one component of brightness was transmitted. Later, 2 additional "patched" color components were
added, which "colorize" this black and white picture. On the one hand, this had the advantage that old S / W devices continued to function, and on
the other hand, it was possible to save transmission capacity instead of generating 3 independent RGB signals. The 2 color components can be
greatly reduced in the resolution, without it being perceptible to the eye. Incidentally, this "trick" is also used for digital formats! All digital video
codecs also work on this principle. 
So we're not dealing with RGB, but with YUV (brightness, and 2 color axes).
There are several standards for video signals. Once the "norm", the resolution and frame rate are determined, and the color scheme, which
determines which method "sets" the color. The most common norms are "B / G" (with 625 lines and 50 half-frames per second), and "M" (with 525
lines and 60 or 59.94 half-frames per second). 
The color process is PAL, NTSC and SECAM. 
In the USA, Japan and few other countries, NTSC-M was mainly used (ie 525 lines, 59.94 Hz and NTSC color). 
In Europe (except France) and large parts of the world predominantly PAL-B / G (625 lines, 50 Hz and PAL color). In France (and the early Eastern
bloc) SECAM was used as a color method. There are also some mixed forms ...
The upper 50 (for B / G) and 40 (for M) lines are not part of the image. These were originally "empty" to give the cathode ray in the television time
to return to the starting point. The lower 576 (B / G) and 486 (M) lines, respectively, were for the picture. 
With this method, both PAL-B / G and NTSC-M recorded tapes can be digitized. However, NTSC bands are only digitizable when they output a
"true" NTSC signal. Most local recorders can only do this as a "mixed form", and produce a PAL-M signal ("NTSC-on-PAL-TV" or PAL60), which
is often "understood" by televisions, but with the DVD recorder can not be digitized. If you want to dub NTSC standard tapes, you need a recorder
that outputs real NTSC (either special devices or imported goods).
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How to digitize video signals? 
Digitizing video signals requires an analog-to-digital converter that converts the signal into digital values. Many factors must be right for the result
to be of high quality:

The converter must be calibrated to the correct voltage values of the signal
The signal must be sampled at full bandwidth
The right time to start and end a picture line must be right
Signal aborts must be caught
Unstable signals must be sufficiently "intercepted" and stabilized
An additional audio converter must be synchronously connected to the clock of the video
The sound digitization must be smooth, with good signal to noise ratio, linear frequency response, without phase error and correct level as
PCM 48kHz / 16-bit.

All these requirements are met by DVD recorders from Panasonic to a very high degree.

What is special about signals from video tapes? 

In principle, signals from a VCR are the same as those originally recorded - that is, "normal video signals". However, there are some timing
deviations due to mechanical scanning, which can lead to horizontal "jittering", as well as occasional "signal breaks" caused by banding errors. This
leads to errors, picture failures, asynchronisms and crashes in many digital converters. Not so with DVD recorders.

Where to go with the "content" of video cassettes?

That depends entirely on the personal wishes. If you really want to create "Video-DVDs", you can of course do this with the method described here -
better than "directly" recording on DVD with a DVD recorder. But let's be honest - we have long arrived in the "media-less" time, where we store all
our photos, videos, music, etc. on small hard drives, sticks, memory cards, cell phones or even in the cloud. All this is possible even with old VHS
recordings with this method! A USB hard drive / stick that you connect to the modern smart TV to watch old videos is certainly more comfortable
than a DVD disc, right? Our goal is therefore to create video files on the PC, which can be used arbitrarily in the end.

Which method is used? 

Standardized digitization of video signals is only possible with Panasonic DVD devices and professional Canopus / Grass Valley capture cards.
Only these devices convert both audio and video signals 100% in accordance with standards into digital data. In this manual, we mainly rely on
Panasonic DVD recorders, with which the analog signals are converted. In the simplest case this can be an internal recording on DVD. However,
this does not eliminate all the artifacts of video tapes, and both the DVD medium and the associated video compression are outdated.Therefore, we
rely on the DVD recorder only as an A / D converter, and forward the digitized signal "on-the-fly" via HDMI output to an interface card from
Blackmagic Design to uncompressed it to the PC transfer, where it can be further processed, corrected and encoded into any format.As an
alternative, the professional video capture card "Canopus Edius NX" is briefly introduced. This is a PC card (available in both legacy PCI and PCI
Express x1 versions, unfortunately, either a desktop PC (ATX, μATX, some Mini-ITX) is required, or an expensive one and exotic expansion case
for laptops with PCMCIA (PCI) or ExpressCard (PCI Express) slot, while the DVD Recorder Intensity solution with the "Intensity Shuttle" device
also works on USB3.0 ports. (It should be noted that there are even very exotic USB3.0 PCIe bridges that make it possible to operate PCIe cards,
but that goes against any expense.) The result is video files that can be played on all modern devices.

Is not that synonymous with a USB grabber? 
NO! 
all complete "S

In short:These devices are almost chrott". The converters are hardly suitable even for stable signals to properly convert them. The result is unstable
videos with wrong color values, asynchronous sound, etc. It is simply not possible to play with "something" videos satisfactorily! This statement is
based on many tests and experiences.

The "DVD Recorder Intensity Solution" - What is needed?

1. Player for the medium to be digitized:
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Example: (S-) VHS recorder

A functioning player, depending on the desired medium (VHS, S-VHS, Hi8, etc.). This can be a (S) VHS recorder, a camcorder, or even very old
devices according to the Betamax / V2000 standard.

The respective player should be in good condition and cleaned. In most cases, it is best to use the device on which the tapes were recorded. All in
all, a device should be used, which satisfactorily reproduces your own recordings - as a "rule of thumb". Either you still have the right player, or you
borrow one, or you look at the second-hand market (Ebay), even though there is always a bit of luck. Between 20 and 300 euros you will find
devices of each class.

For further questions about the suitable player, there is this thread:
[FAQ]Which player is suitable for my recordings?

2. A Panasonic DVD recorder with HDMI connection:

 

Example: Panasonic DVD Recorder DMR-EH495

In principle, all Panasonic models that have an HDMI output are suitable:

DMR-EH65
DMR-EHxxx (all "EH" with 3-digit model number)
DMR-EXxx (all "EX" with digital tuner)
DMR-EZ49 (VHS-DVD-Combi without HDD)

Also these devices are numerous and in good condition on the used market (Ebay) to find. From 50 euros to have these Panasonic recorders.
[INDENT]

Why not other manufacturers with HDMI output? 
Basically, these work on the same principle and can theoretically be used to convert to HDMI. We have tested all series of Sony / Pioneer, JVC,
Toshiba, Samsung and LG - also a few "no-names". None of the built-in A / D converters on these other devices meet all of the analog-to-digital
conversion criteria as perfectly as the Panasonic devices.

[/ INDENT]

3. A "special" HDMI splitter that can remove the signal protection:
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... EXACTLY THIS HERE!

This model can be easily found, for example, if you only enter "HDMI Splitter" on Amazon or Ebay. The device circulates under many names - but
the part can be identified on the housing.

This splitter does not pass the HDMI signal protection of the Panasonic recorder to its outputs. This is needed so that the HDMI signal can be
recorded with the interface card. Cost point: approx. 20 Euros.

There are increasing reports that these splinters have recently been modified under certain circumstances and are no longer usable for this
purpose, which is unfortunately not recognizable from the outside. 
Therefore, there is a discussion thread HERE, which offer is currently correct:
[FAQ] Which HDMI splitter is currently suitable (dubbing protection)?

4. Blackmagic Intenstiy card:

Intensity Pro: PCI Express Card / Intensity Shuttle: External hardware with USB3.0 or
Thunderbold

This card is available in 3 versions: "Intensity Pro" (PCI Express card for installation in desktop PCs), "Intensity Shuttle USB3.0 (external module
for connection to USB3.0 ports)," Intensity Shuttle Thunderbold " (for Apple devices).

The hardware installed is exactly the same. Which model you choose depends only on whether you own a desktop PC and want to install a PCIe
card, or if you are looking for a flexible external solution for USB3.0, which can also be operated on various notebooks. It should also give a
slightly rarer version called "Intensity" (without "Pro") for the PCIe slot. This ONLY has HDMI inputs and no analog part. If you find these, you
can save a lot of money as a desktop PC user, because we do not need the card's own A / D converter. OWINGEN USB3.0 ports are required for the
external model. USB2.0 does not work!

Unfortunately, the card does not work on any USB3.0 controller. Since the device is still from the "modern era" of USB3.0, you can no longer
predict exactly which chipsets it works - there are certainly some. If in doubt, you will have to test it. Chipsets from NEC, Renesas and Intel
(eXtensible Host Controller) have already been successfully tested. If there are problems with the installation of the card, there is a discussion
thread HERE:
Problems with putting the Intensity Capture card into operation
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Problems using the Intensity Capture CardWhy not
The reason is simple. The analog inputs of this recording card behave very "own". The technical values of the inputs differ slightly from the norm.
The audio level and the white point of the digitized signals is not standard. Unstable signals, directly from VHS devices can thus practically not be
detected without dropouts. 
We use the card as a pure "digital interface" to read HDMI signals uncompressed in the PC. We leave the digitizing of the analogue band signals to
the converters in the DVD recorder.

[INDENT] connect the VCR directly to this card? Or the DVD recorder analog?

Why no other HDMI recording card (so-called "Game Capture Cards")? 
Yes, there are several other recording cards that can read in HDMI signals. However, these all compress hardware-side into H.264 format. We
want to achieve that (usually) in the end, but only after final editing! For this we need UNCOMPRINTED video data in the PC, and supplies the
previously known only this Blackmagic card. 
Should there be any other (possibly cheaper) and "pure" HDMI capture card that can read uncompressed, then that will certainly be an alternative.

[/ INDENT] Blackmagic cards can be found at many online retailers.

Every nowand then a used card appears on Ebay ...Cost: Approx. 130-200 €.

5. 2x HDMI cable:

... 2 cables are needed.

The cables should be as short as possible, this prevents cable clutter.

The easiest way to search Amazon or Ebay for "HDMI 0 5" - there you will find it. Cost point:
approx. 5-10 Euro

6a. Variant 1: High quality scart cable:

... also best "short".

To connect, for example, a (S-) VHS player to the DVD recorder via scart, a short, high-quality,
fully connected and well shielded cable (recognizable by the cable thickness) should be used.
Here audio and video are transmitted simultaneously. One finds also with Amazon or Ebay -
best simply "Scart 0 5" enter.

Cost point: approx. 5 euros.

6b. Option 2: Separate connection via audio cinch, video or S-video cable (+ possibly
scart adapter):

What exactly is needed depends on the type of connection of the player - it will be described later in the tutorial. It never hurts to have a few more
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audio / video cables in the "fundus".

With an S-Video Hossiden cable, a CVBS cinch video cable, a stereo audio cinch cable and a high-quality scart adapter, you are well positioned
and has almost all options. A possibly to be procured Scart adapter should have 4 connections (2x audio, CVBS and S-video), switchable and as
high as possible. The usual cheap "plastic parts" get after a short time loose contacts. These types of cables and adapters are also available for a few
euros on Amazon or Ebay.

6c. Option 3: Connecting a camcorder:

In this case, often no special cable is needed, as it is usually already included. With this camera can be connected directly to the DVD recorder.

The exact connection is described in the tutorial.

7. A PC / notebook with PCIe x1 slot (Intensity Pro) and / or USB3.0 port (Intensity Shuttle):

For the recording of video data except a reasonably fast hard disk no special hardware requirements are made. There must be only one PCIe slot or
one supported USB3.0 port. For the further processing of the videos, however, it is very useful if the computer offers a little power reserves - the
faster the videos are encoded later.

A PC / notebook with Intel Core processor (or comparable AMD) from about 2012 is "recommended". The operating system supports Windows XP,
7, 8 and 10. Even with Linux and Mac OSX should work, but here is the subsequent processing completely different than the "common" Windows.

8. Hard disk:

The hard disk must be able to "write away" about 25 MB per second. This theoretically creates any external 2.5-inch hard drive today. When
connecting to USB2.0 it will be "scarce", but if need be, it should work.

Highly recommended are any type of hard drives (3.5-inch or 2.5-inch), which - as always - internally / externally connected at full speed (SATA,
eSATA, USB3.0) are connected to the PC and run stable , The capacity is about 1 TB of "temporary" free space.

It takes about 80GB per hour of raw material.

Connecting a playback device to the DVD recorder:

Basically, the connection of playback devices to the DVD recorder is the same as if you would dub directly to DVD. Nevertheless, there are a few
"tricks" on how the signal transmission from different devices can possibly be improved. Connection of an S-VHS device:

Example: A "normalsterblicher" S-VHS recorder

Required cables:

audio vi

Variant 1) High-quality scart cable (fully wired, shielded)Variant 2) S-Video Hossiden cable + stereo audio cinch cableVariant 3) Video via scart, a
stereo cinch (for S -VHS devices without separate S-video output)

Connection:
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Variant 1:
The S-VHS device comes with a fully wired Scart cable from the output of the S-VHS recorder (usually AV1 / TV) with the AV2 scart Input of the
DVD recorder connected.

  

Variant 2:
Since S-VHS devices usually have a separate S-Video Hossiden socket, as well as separate stereo audio cinch sockets, the S-VHS device can also be
connected via separate connections (S-Video via Hossiden cable + Audio via stereo cinch cable) to the front AV inputs (AV3) of the DVD recorder.
This has the advantage that often interferences of the video signal are reduced or avoided in the audio channels, which can otherwise be noticeable
as annoying "humming" in the audio signal in quiet places. 
This is the optimal connection variant.

 

Variant 3:
If the S-VHS device used does not have a separate S-Video Hossiden output and the output is only possible via scart, it is recommended as an
improvement over variant 1, a high-quality scart-in / out adapter to using only the S-video signal is tapped, and a stereo RCA cable to tap the audio
signal from the separate audio jacks to use. 
Again, the front AV (AV3) inputs of the DVD recorder are used again.
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Connection of a VHS device:

 

Example: A "simple" 6-head hi-fi stereo VHS recorder

Required cables:

Variant 1) High quality Scart cable (fully wired, shielded)Variant 2a) Composite RCA cable + stereo audio RCA cableOption 2b) Video via Scart,
audio via stereo RCA (for VHS devices ( most) without separate CVBS output)

Connection:

Variant 1:
The S-VHS device is connected with a fully wired scart cable from the output of the S-VHS recorder (usually AV1 / TV) with the AV2 scart input
of the DVD recorders connected.
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Variant 2a:

Simple VHS devices usually do not have a separate CVBS cinch output. Nevertheless, there are a few devices that provide such an output. In this
case, the VHS device can also be connected via separate connections (CVBS via RCA cable + audio via stereo RCA cable) to the front AV inputs
(AV3) of the DVD recorder. This has the advantage that often interferences of the video signal are reduced or avoided in the audio channels, which
can otherwise be noticeable as annoying "humming" in the audio signal in quiet places. This is the optimal connection variant. Variant 2b:
Since simple VHS devices usually do not have a separate CVBS cinch output and the video output is only possible via scart, it is recommended as
an improvement over variant 1 to use a high-quality scart-in / out adapter, which only the CVBS signal is tapped, and to use a stereo cinch cable to
tap the audio signal from the separate audio jacks. 
Again, the front AV (AV3) inputs of the DVD recorder are used again.
(Very simple mono devices usually do not have a separate audio output, so that the audio signal can also only be taken from the scart socket.) Here
then offers the tap of the audio signal from the scart adapter to the Scart The audio connection is then made with a single cinch channel from the L
socket (white) of the Scart adapter to the L socket (white) of the front AV Inputs of the DVD recorder.)

 

Connection of camcorders, mobile players etc .:

Required cables:

Variant 1) The supplied with 3-fold RCA CVBS / audio AV cablevariant 2) possibly an additional S-video cable Variant 1:
All analog camcorder (Video8 , Hi8) usually have a 4-ring phone jack for the audio / video output, which is adapted with a standard supplied
adapter cable to 3 RCA plug (yellow, white, red). These can be connected directly to the front AV sockets (AV3) of the DVD recorder. 
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Mono devices that have only one audio cable (white) are connected only to the white (L) audio jack of the front inputs of the DVD recorder.

Option 2:

If it is an S-VHS (-C) or Hi8 camcorder, they usually have an additional S-Video output,
which should then be used. This is usually an additional Hossiden socket on the device.
In this case, the video signal is picked up from this jack via S-Video cable, and the
audio signal from the "normal" AV strip. The S-Video cable is connected to the front
AV input of the DVD recorder (AV3). The "normal" AV cable only connects the stereo
audio plugs (red / white) to the DVD recorder. The yellow CVBS cinch remains free in
this case. Mono devices that have only one audio cable (white) are connected only to the
white (L) audio jack of the front inputs of the DVD recorder.

Connection of other / exotic playback devices (Betamax, Video2000, VCR, etc.):

At this point I would like to give no detailed connection instructions because of lack of
experience with such devices. Basically, however, the connection is the same as with
VHS devices. If a scart connection is available, it can be used with this CVBS video and audio transfer. If there are separate output sockets, these
should be brought forward to the Scart connection. Note:
Also, the connection of VERY OLD devices (eg VCR format), which have only one RF antenna modulator output, can theoretically be easily
recorded! The connection then takes place at the "RF-In" socket of the DVD recorder. Audio and video are then transmitted via HF.
In such a case, all you have to do is start an automatic station search on the DVD recorder while (!) The source device is playing, or the test pattern
switch of the modulator is activated. If the transmission channel of the source device (often adjustable by screw in old devices) is known (usually
UHF 36), this channel can also be stored manually on the DVD recorder on a station program slot. 
Nevertheless, it should be noted that this connection variant only applies as "emergency solution", if there is no other connection option. Even
extremely old devices can be retrofitted with some electronics knowledge, so that a composite or S-video signal + audio (usually mono) can be
tapped.

  

Special case: Digitizing overdriven signals from ancient Vicon tube cameras:

If you want to digitize very old material from tube video cameras from the 80s (Vidicon), they are often noticeably overexposed, because these
sensors have a "soft" saturation range and overshoot the "standard white point".

Here is a tip: TIP! : Digitizing overdriven signals from analogue old-age cameras (Vidicon ...)
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Setting the video input signal on the DVD recorder:

Option 1 - Connection via front AV input (AV3):

If the connection to the DVD recorder is made via the front AV inputs (AV3), only the input channel (AV3) has to be connected be chosen - done!
The recorder automatically detects if a CVBS cable (yellow cinch) or an S-video cable (Hossiden) is connected and switches the input internally
correctly.

If a mono audio signal with only one channel is connected, it should be connected to the L (white) jack. Then this signal is automatically mixed by
the DVD recorder to both stereo channels, provided that the R socket (red) remains free.

Variant 2 - Connection via Scart (AV2):

If the connection to the DVD recorder is made via scart to AV2, the AV2 scart input in the OSD menu of the DVD recorder must be set to the video
signal present. This is done as follows: Setup key (remote control) -> navigate to "additional functions" -> Setup -> Connection -> AV2 input

 

Now either "Video" (= CVBS) or "S-Video" (= Y / C) has to be set.
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If a pure VHS recorder is connected via scart, "Video" must always be selected.

If an S-VHS recorder is connected via scart, "S-Video" should be selected in any case, whereby on the S-VHS device the Scart output must be
configured accordingly on S-Video! An S-VHS device can also output FBAS. Depending on the model, this selection is made either via its OSD
menu or via a mechanical selector switch on the back of the device. (Note the operating instructions of the respective device) If the configuration is
not correct, the following "symptoms" occur:

Recorder output on CVBS, DVD recorder input on S-Video: black and white image with "dot matrix" coated
Recorder output on S-video, DVD recorder input on CVBS: "pure" black and white image

If BOTH devices are set to S-Video, the result is a correct color image. But even if BOTH devices on CVBS (video) are set to get a correct picture -
only then the transmission is not optimal. The automatic connection detection of the front AV sockets remains completely unaffected by this setting!
Due to the coordination effort and crosstalk sensitivity, the connection via front AV (AV3) is recommended.

Variant 3 - Connection via RF Modulator (Antenna):

If a very old video device is actually used, which is connected to the DVD recorder via HF antenna output, the channel setting is made as follows:
Setup button (remote control) -> navigate to "further functions" -> Setup -> station table

Connecting the DVD recorder to the Intensity card via HDMI:

The HDMI output of the DVD recorder is HDCP-encrypted, so only equipped displays / recorders can handle this signal. For legal reasons, the
Intensity card does not handle HDCP decryption, so it must be interposed above the 2-way splitters to break this encryption. This is legally harmless
in this case, because this device is available for a free and it is pure SD source material (where the connection could also be done analogously,
which is only for technical reasons not recommended!). It is recommended (as mentioned above) 2 short HDMI cables to curb the "cable salad" ...
1. The HDMI output of the DVD recorder is connected to the input of the splitter
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2. Any output of the splitter will be connected to the HDMI input of the Intensity card

Example: Intensity Shuttle USB3.0

The connector is equivalent to the Intensity Pro PCIe card - where the input is located on the slot panel on the back of the PC. This is how it should
look like (example: Intensity Shuttle USB3.0):

This cabling is already sufficient for operation. To avoid any difficulty in getting the Intensity card into operation for the first time and configuring
the DVD recorder, as well as for general control over the ongoing dubbing, it may be advisable to connect another TV / monitor to the DVD
recorder that controls the output of the DVD Plays back.

This can be connected via HDMI to the 2nd free port of the splitter, or to the AV1 Scart output of the DVD recorder (CVBS, S-Video or RGB). If
no monitor is near or to be used, a simple CVBS cinch cable from the video output of the DVD recorder to the video in the intensity card can be
connected for the first start-up in order to capture a picture when setting up the HDMI output DVD Recorder menu on the PC before switching to
HDMI. However, this connection should NOT be recorded later !
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If the Intensity Shuttle USB3.0 version is used, it will still be connected to the PC / notebook via USB3.0:

 

Finally, of course, all devices (video source device, DVD recorder and splitter) must be powered. This is best suited for a multiple power strip:

Why not connect the DVD recorder without HDMI splitter to the inputs of the Intensity card in the same way? 
The A / D converters of the analog inputs installed in the Intensity card do not convert 100% to the standard. The white point varies with every new
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activation of the card and is slightly above the target value, which can cause clipping in bright areas of the image! In addition, one would lose in this
way image information in the peripheral areas, as the DVD recorder from Panasonic on the analog outputs only a 52μS signal excerpt convert
(704x576 or 704x480 pixels). Via HDMI, the digital video stream of the A / D converters installed in the DVD recorder can be read in a bit-
identical manner 1: 1.

Installation and configuration of the Blackmagic Intensity card:

Now the Intensity card must be installed and set up on the PC. 
If the "Intensity Pro" version is to be used as a PCIe card, it must first be installed according to the instructions in the PC - this will not be discussed
here. 
If you opt for the external "Intensity Shuttle" variant for USB3.0, you should make sure that there is a working USB3.0 slot and the card is
recognized by the computer when you connect it ("other devices" in Device Manager), and the chipset is thus compatible.

If the Intensity hardware is installed or connected to the PC and connected to the DVD recorder, the installation package called "Desktop Video"
must be downloaded from the Blackmagic page, which contains the drivers and the recording software. The "Desktop Video" installation package
can be downloaded here:

Blackmagic Design: Support Center

Which version you have to download, unfortunately, must be tested! The "SDK" versions should NOT be downloaded. Recommendation for
Windows 8.1 (Windows 7? 10?): Desktop Video 10.3.5

Recommendation for Windows XP:https://www.blackmagicdesign.com/en/support/download/ce14700abedd4d57a1ea2786938795f2/Windows)

Desktop Video 9.5.3 (the last executable version in XP is 9.8: This is a normal setup routine, where there is nothing to note. The card (also the
USB3.0 version!) Should be CONNECTED during the installation! Under certain circumstances, the firmware of the card is updated during the
setup - if this message appears, it must be confirmed with "Yes"! After installation, there should be an entry called "Blackmagic Design Control
Panel" under the Control Panel (!) Items (see all Control Panel options):

If the selection elements are active, the card is ready for operation.
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If the items are "grayed out", the card is not installed correctly or is not recognized by the system.

In this case, you should first check whether the card appears in the Device Manager and the driver is installed correctly:
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If so, try another "Desktop Video" version. (To do this, please uninstall the already installed first, restart, install alternative version, then restart
again).

If there are any problems with the installation or start-up of the Intensity card, this discussion thread is available:
[FAQ]Problems with commissioning the Intensity Capture card

Now in the "Blackmagic Control Panel" of the system control 2 settings in the first tab "Settings" must be checked or adjusted:

"Set input": "HDMI Video & HDMI Audio"
"Set default video standard as": "PAL" [or "NTSC" if NTSC is to be dubbed] - (NOT "PAL Progressive" or "NTSC Progressive" !!)

The remaining settings are irrelevant. Now the Blackmagic recording software "Media Express" must be opened. For this you will find in the start
menu in the program group "Blackmagic Design" -> "Desktop Video" the entry "Blackmagic Media Express".
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This software is for recording and previewing. Here are 3 settings under "Edit -> Preferences" controlled and possibly adjusted:

"Project Video Format": "PAL" [or "NTSC"]
"Capture File Format": "AVI 8-bit YUV"
"Capture audio and video to": {here the path to the recording hard disk must be set}

If you now set the software to "Capture", the picture from the DVD recorder will now appear.
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Usually, nothing appears on the first boot since the HDMI output format of the DVD recorder is not set correctly to 576i (PAL) [480i (NTSC)].
This setting returns to "Automatic" if the DVD recorder has been disconnected from the mains for a long time. The HDMI output format and
various other settings that are still to be made on the DVD recorder are described as follows, and can most easily be done via an additional monitor /
TV connected to the DVD recorder, which can either be connected to the 2nd splitter via HDMI. Output or analog (Scart AV1 or separate outputs).
If no additional monitor is available, the configuration can also be made by connecting a composite cinch cable from the "Video Out" of the DVD
recorder to the analog "Video In" of the Blackmagic card. Then change the video input of the Intensity card in the Control Panel to "Composite
Video" to provisionally get an image.

This configuration should

NOT be used

for recording - this is only to get a picture of the DVD recorder until the HDMI output is configured! Then you can switch back to "HDMI Video &
HDMI Audio" in the "Control Panel", and the picture including the menus will then be transferred via HDMI to the recording card. Splitter and
HDMI must be connected at the same time so that the DVD recorder recognizes the connected HDMI devices.

Configuration of the DVD recorder:

If a picture of the DVD recorder is now visible (on an external monitor or "provisionally" via CVBS on the PC), a few settings must still be
configured in the setup menu.
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First, the main menu must be accessed via the "FUNCTION MENU" button on the remote control, and then via "Far. Functions -> Setup "the Setup
Configuration menu will be invoked. The navigation and selection is done with the directional pad, the OK button and RETURN.

The following settings must be made or checked:

Display -> Gray Background: OFF {This determines that no gray screen will be superimposed on poor signals or noise

Connection -> TV system: PAL [resp. NTSC] {If true NTSC material is to be dubbed by suitable players, the recorder and at the same time
the recording software (!) Must be switched over
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Connection -> HDMI Settings -> HDMI Video Format: 576i / 480i {only this setting brings native PAL [NTSC] output, 1: 1 from the A / D
converters - all other settings cause contra-productive scaling / deinterlacing of the DVD recorder! This format is also consistent with the
configuration of the recording software described above - it should now be possible to transfer images via HDMI.

 

Connection -> HDMI Settings -> Digital Audio Output: HDMI / Optical {You must select "HDMI / Optical" to allow audio output via HDMI
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Connection -> AV1 output (Scart): "Video" or "S-Video" {Affects only one additional monitor / TV connected to AV1. RGB is not possible
when HDMI output is active

 

Connection -> Settings AV2: "Video" or "S-Video" {Affects a scart connection to AV2 from an external player. Must be set according to the
source signal (see above). Irrelevant when connecting via front AV ports (AV3)
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Optional channel setup for connection via RF modulator:

Transmitter table -> station search {for automatic finding of the transmission channel - the source device must output a signal during this time
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Transmitter table -> Manual search {for manual tuning and storage of the transmission channel (usually UHF 36)

Now the setup menu can be left again.

If the skin picture is now visible again and the menu is closed, there are 2 further settings
that determine the pretreatment of the source video signal. These are called up using the
"DISPLAY" button on the remote control:

Video -> Sharpness: ON {Affects only composite video signals (irrelevant to S-
Video). When set to "On", the full resolution / bandwidth of composite video
signals is decoded, with minor cross-color effects in the form of "dot crawls"
(which is completely normal). When set to off, the bandwidth and cross-color
effects are reduced, but the picture becomes noticeably blurred!

Video -> NR Input: ON / OFF / Auto {Switches the internal temporal noise reduction of the DVD recorder to reduce tape noise. This provides
useful results in many cases. Who wants to make completely "raw" dubbing, and wants to make the noise reduction in the following
processing on the PC, these off. With "Automatic", the recorder itself detects band signals and turns the noise reduction on or off when "non-
band" sources are connected.

Now the DVD recorder is configured!

Dubbing:

When all devices have been connected, software set up and all settings made on the DVD recorder and the player is in good condition, the dubbing
can now start. 
There should be enough temporary space for the raw video data on the target partition selected above. Rule of thumb: about 80 GB per hour. 
If you want to dub several tapes one after the other, before you edit / encode, or even transfer 10-hour LP tapes to a single track, you should have
about 1-2 TB of space. Even more does not hurt.
However, if you want to dub only a maximum of about 1.5 to 3 hours, and then directly processed / encoded, which may also be enough 200-300
GB "work capacity" from ...

The dubbing process is now as follows:
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Turn on all devices
Start Media Express software and switch to Capture mode

Insert tape, check tracking, rewind to start point, start playback and press "Capture" in Media Express ... after the dubbing also to exit.

The result is an AVI video file in UYVY 4: 2: 2 raw format, 720x576 pixel resolution and PCM 48kHz 16-bit stereo audio.

The further processing and encoding of these raw recordings can be done in many ways - * a * possible approach will be discussed below. High
Quality Alternative - Canopus Edius NX Capture Card:

If you have the option (to all desktop PC owners) to operate a PCI or PCI Express card, you should take the Canopus Edius NX card to heart.

It is a PC card with a cable whip for all connection signals (and optional front panel). The card provides direct connection for video / S-video signals
from VHS and other video equipment - saving a lot of cabling. The conversion quality of the analogue audio / video signals is AMAZING, and just
like the Panasonic DVD devices, it is absolutely standard. The card also offers even 2 small advantages over the Panasonic DMRs:

The correction of band jitter (horizontal "image shake") is once again * slightly * better
The black and white values, as well as saturation, etc., can be adjusted on the hardware side (Proc-Amp) - this can be very beneficial for video
recordings that are very "out of the norm"

Otherwise, the achievable A / D converter quality is identical. The card works - as the name suggests - with the professional video editing software
"Edius" (from version 3) of the company Canopus (now Grass Valley) together. Most of the Edius software is optionally available, now and then in
the bundle. An older version of the software is otherwise quite cheap to get. Detailed comparison and advantages / disadvantages of the Canopus
NX card compared to the DVD recorder Intenstiy solution:
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In summary, if installation and operating options (desktop PC) are present, the Canopus NX card can replace the combination of DVD recorder,
splitter and Intenstiy card 100%. Connection and wiring:

First, the card must be installed in a free PCI or PCI Express x1 slot (depending on the version).
With the appropriate adapter cables are then Composite (CVBS) - / S-Video (Hossiden) - and audio ports available (comparable to the front
AV inputs of DVD recorders)
The connection of playback devices is identical to the connection to the front AV terminals of the DVD recorder (see above)

Commissioning:

After installation and connection of course, the appropriate driver and the Edius software must be installed. Due to a lack of practical experience, I
am unfortunately unable to give any precise details - but there are many competent and nice forum participants on the way here, who are happy to
answer special questions! Sources of supply:
Since this is rather professional video equipment, which does not count towards widespread consumer goods, it is not always easy to procure this
already older, and no longer available cutting card in the used market. At Ebay, for example, rarely appear on individual offers. 
Otherwise the company "magic multi media" (Digitalschnitt.de) is a good contact point: digital cut - magic multi media: Canopus EDIUS NX
(EDIUS NX for HDV)
Cost: about 300 euros incl. Edius software (older version)

OPTIONAL: Advanced jitter correction with special Panasonic DVD Recorders of the old generation:
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Example: Panasonic DMR-ES10

If you want to dub extremely bad tapes that have been copied multiple times or have mechanical errors that tend to be extremely "wavy" or "shaky"
during playback, the A / D converters of the first two generations of Panasonic DVD recorders offer (until 2005) a special jitter-stabilization
function that completely eliminates these errors pratically and the converted image is just like "concreted" straight.

This "special" feature has the following models:

DMR-HS2
DME Exx (all the first "E" series, not "EH"!)
DMR-ES10 (RECOMMENDED! - no unnecessary disk)
DMR-EH52, DMR-EH50, DMR-EH60

Since the device is used in loop-through operation, the model DMR-ES10 is recommended, as this is the one "the smallest" device with these
converters, and on the other a pure DVD device, which has no unnecessary hard drive. The even older E Series and HS2 devices can also be used,
but are significantly "heavier", have a hard drive, and the DNR (Noise Reduction) can not be used in looping operation. The models DMR-EH52 / -
EH50 / -EH60 are practically identical to the DMR-ES10, but with hard disk. 
... in the following, therefore, only the "DMR-ES10" language (although the other models also work).

In order to use the special jitter correction feature of these devices, the video signal of the playing tape device must first be converted with one of
these special devices. Unfortunately, these recorders of the first generation do not have an HDMI output, which is why the digitally converted image
can only be output again as an analogue signal, which then has to be digitized again! 
Therefore, the "upstream" of such a Panasonic device is only an optional supplement (!) To said recording hardware. These "special" recorders have
to be connected as an EXTRA device (!) Either a) in front of the 2nd Panasonic recorder (which outputs to the Intensity card via HDMI), or b) in
front of the Canopus NX interface card!

Anyone digitizing band signals directly with a "newer" Panasonic recorder via HDMI in combination with the Intensity card will already receive a
"good" jitter correction, which in most cases is already sufficient to obtain a satisfactorily stable picture. The jitter correction of the Canopus cut
card with direct connection is even better. 
The Vorschaltung of such a Panasonic device is therefore practically necessary only in special "hardship". The stable image signal output there will
then be digitized again in accordance with standards by the 2nd DVD recorder or the Canopus card. 

Disadvantage:
Compared to the direct connection of the tape device to the HDMI DVD recorder or the Canopus interface card, there are also two disadvantages,
for example if a DMR-ES10 is connected upstream for jitter correction: 
1. Digitize the old devices with the special jitter correction only with 704x576 (or 704x480 at NTSC) pixels around (52μS signal cut), instead of
with full D1 cutout of 720x576 pixels (or 720x480 with NTSC) pixels (53.33μS signal excerpt). This leads to 8 black empty pixels at the left and
right edges of the picture, which do not contain a picture part of the source. Depending on the original image source (which is either fully featured or
the image area slightly shifted), there may be small missing (trimmed) image parts around the edges (which is mostly irrelevant).
2. The transducers are more sensitive to "slimmed-up" video sync pulses, which makes it a little easier to "skip", such as with erroneous tracking or
weak signals. 
3. The optional Proc-Amp function of the Canopus cutting cards (which is not present on the DVD recorders) is useless if a DMR-ES10 is
connected upstream and must be set to "Standard".

Connection:

Here are two special features to consider in the wiring:
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1. Since the audio A / D converters of the "old" Panasonic devices (described here with the particular jitter correction) have a small (albeit
irrelevant) error, and the sound signal is generally not unnecessarily 3-fold We have to bypass the audio inputs of the DMR-ES10 and connect the
audio connectors of the tape device directly to the end device (2nd HDMI DVD Recorder + Intensity Card OR Canopus NX Interface Card). Only
the video signal will be sent to the DMR-ES10!

2. The tap of the analog output video signal of the DMR-ES10 (which is then led to the following device) must be made via S-video from the AV1-
SCART output (!)! The separate rear video jacks (ONLY the OUTPUTS) of ALL Panasonic DVD recorders are ERRORED and cause brightness
variations depending on the picture content. Therefore, the separate CVBS RCA, S-Video Hossiden and 3xYUV cinch outputs should not be used
for tapping! Only the SCART AV1 output provides perfect signals! The Scart-AV1 is available with FBAS, S-Video or RGB. Because RGB exits
anyway (because of color space conversion), remain composite and S-video, of which the latter is the highest quality (no relevant loss).
In any case, a switchable Scart adapter is needed, so that the S-video output signal of the AV1 Scart can be tapped via Hossiden cable.

First, the S-video output signal of the AV1 scart socket must now be connected via Scart adapter to the input of the following device (another DVD
recorder + Intensity OR Canopus interface card):

  

Next, only the VIDEO signal of the tape device is connected to any input of the DMR-ES10. Since the DMR-ES10 (and also DMR-EH52 / -EH50 /
-EH60) has rear separate inputs for CVBS or S-video (AV4), you can use this (or the front inputs (AV3)). Depending on whether you connect a
VHS device via CVBS or an S-VHS device via S-Video, the connection looks like this:
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The connection to the DMR-ES10 can also be made via Scart to AV2 (although it only depends on the image signal), if the source device has again
separate audio outputs, which can then be connected directly to the terminal. In this case, the AV2 input in the setup menu of the DMR-ES10 must
be configured for the correct input signal (CVBS or S-video). This is similar to the newer models (see above). The direct connection is easier and
less error-prone.

Now the audio signal from the AM DMR-ES10 VORBEI tape recorder is connected directly to the end device (2nd DVD recorder upstream of the
Intensity OR Canopus interface card).

The whole thing looks like this:

Important instructions:

1. As mentioned, the DMR-ES10 must be connected to the terminal via S-video from the AV1-Scart (!)! (Configuration of the AV1 output see
above).

2. If the DMR-ES10 is connected in front of another HDMI DVD Recorder + Intensity card, make sure that the DNR function (image noise
reduction) is only activated with a maximum of ONE DMR unit. The configuration is done in the same way ("DISPLAY" button -> Video) as on
the newer HDMI-DMRs (see above). If you would like to use this function in general, you can set * both * Recorders to "Automatic" (then the DNR
on the 2nd terminal will be deactivated automatically when connecting a DMR-ES10). 
If a DMR-ES10 is operated in front of a Canopus NX interface card, the DNR should be set to "off", as it is better to use the variable DNR options
of the NX card, just as if the tape device were connected directly.

3. The TONSPUR of the successful dubbing must be delayed by 120ms for direct audio connection from the source to the line unit in the post-
processing when a DMR-ES10 is interposed! In VirtualDub this can be done, for example, by entering the value "120" ms (positive) under "Audio
skew correction" in the "Audio -> Interleaving" menu.

Why not connect the DMR-ES10 without 2nd HMDI-DVD-Recorder + HDMI-Splitter analogue with the inputs of the Intensity-Card? 
The A / D converters of the analog inputs installed in the Intensity card do not convert 100% to the standard. The white point varies with every new
activation of the card and is slightly above the target value, which can cause clipping in bright areas of the image! Therefore, a 2nd DVD Recorder
(via HDMI on the Intensity Card) OR the Canopus Interface Card must be used to digitize the output of the DMR-ES10.

OPTIONAL: Direct recording / saving as MPEG2 on the internal hard disk of the DMR recorder, and reading it out via PC (instead of
uncompressed recording via HDMI capture):
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Who the effort, hard disk space or costs for Intensity recording card and splitter shy, and instead with the (qualitatively slightly worse) caching of
the raw recordings as MPEG2 video would like to be satisfied, it should be said that it is the (somewhat cumbersome) Possibility to export MPEG2
recordings from the internal hard disk of a Panasonic recorder to the PC.

Procedure:

The connection of analogue players to the DMR recorder is exactly the same as described above. The connection of the DVD recorder to the PC via
HDMI, splitter and intensity card is omitted in this case.

The best way to boot from an empty, freshly formatted HDD in the DMR recorder (can be selected in the menu under "HDD management. 
") "Recording quality" should be set to the "XP" mode as possible, with MPEG2 recordings in ~ 8 Mbps (Audio: AC3 256 kbps) 
DNR noise reduction should be enabled in any case (as described above).

Now the analogue tapes are transferred to the internal HDD of the recorder simply by pressing the recording button of the recorder in HDD mode.
Each individual recording, which can be of any length, will later each result in a raw MPEG file. 
Cutting and excessive erasing or re-organizing on the internal recorder disk should be avoided.

Reading the hard disk:

The reading takes place when all dubbing has been completed. In the 8 MBit / s XP mode, for example, a built-in 160 GB hard drive is enough for
about 30 hours of video.

There are (depending on the model) Panasonic recorder with (mostly) IDE hard drives, and a few with SATA hard drives. An adapter (preferably
USB3.0) from IDE or SATA to USB is required - although not all adapters cope with the non "PC-usual" formatting of recorder hard disks. Better is
the connection to the internal SATA or IDE port (if still available) of a desktop PC.

To do this, the recorder must be opened and the hard disk removed from the recorder, or an adapter plugged in when installed:

Now it should be checked whether the drive has been correctly recognized by the PC (in the case of direct connection, first in the BIOS / UEFI -
otherwise in the Windows Device Manager).

The hard disks ALL Panasonic recorders are described in a completely "own" format, which is not PC-compliant (ie no regular MBR / GPT + file
system). Older models use the UDF file system, newer the "MEIHDFS" format. 
The content of the hard disk must NOT be changed / deleted in any case (!!) - otherwise the recorder will not be able to boot from it later!
(CAUTION: If you open Windows Disk Management, you will be asked directly if you want to initialize the "new disk" and write a MBR - NO!
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It makes sense to first draw a raw data image of the hard disk and save it as a * .dd file on the PC. This is very easy, for example, with the freeware
tool "Data Recovery DD": 
https://www.datarescue.com/photorescue/v3/drdd.htm

Then the recorder HDD can be back again and the recorder closed again. Everything else is done on the dd image file.

In order to be able to extract the MPEG data from the dd image, there is the project "panasonic-rec": 
https://github.com/leecher1337/panasonic-rec

Here are 2 tools offered - one for each file system (UDF / MEIHDFS). This makes it easy to extract the VRO structure from the image using a
command line. How exactly does it, is there in the "Readme". When you come to the image, this step is really very easy.

Further information and discussion can be found here: Read hard drive of Panasonic DMR via PC (tool wanted)

In principle, only the * .VRO files are interesting. Each individual VRO file contains one recording of the recorder. It contains the MPEG2 video as
well as the AC3 audio stream.

Further processing of the extracted VRO files:

The further processing by VirtualDub can theoretically and practically be the same as with uncompressed raw videos that were dubbed via Intensity
card / HDMI (see below). 
In order to load the MPEG2 / AC3 videos into VirtualDub, the programs "AviSynth" and "DGIndex" as well as 2 plugins for the program
"AviSynth" have to be downloaded and installed. 
A small script is created, and then the VRO files can be loaded and processed in VirtualDub just like uncompressed AVI video.

How exactly this works, has been discussed here: VRO from Panasonic DMR further processed

Editing and encoding of raw dubbing:

Here is first to be described, which peculiarities to pay attention to the huge recorded raw videos, how they can be further improved, and what to do
in the end with the finished videos. First, something about the correctable "image errors" of analog tape recordings:

1. Jitter:
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2. Noise:

In contrast to video signals that are NOT from tape devices (ie directly from cameras, television, or digital DVD, DV or receiver devices) - so not
mechanically recorded on videotape, have output signals from video Band devices always have a more or less strong "jitter". This means that the
signal pulses marking the beginning and end of each image line can always deviate slightly from the mean and fluctuate for each line. This comes
from mechanical tolerances of the video-Abtastkopfes during recording and playback, and manifests itself in a (usually only slight) horizontal
"shaking" of individual image areas (especially on fonts and small details visible).This phenomenon is as old as the tape recording and is
synonymous with the normal playback on old TVs recognizable. Depending on the age and condition of the tape, and depending on the recording
and playback device, it is more or less strong. In digitization, it also depends on the A / D converter how much it responds to the fluctuations - it
depends directly on how much jitter remains in the digitized image, and whether this is largely or even almost completely intercepted.The correction
of jitter can NOT be done in the post-processing, but must be done during the A / D conversion. This task is done quite well by the aforementioned
DVD recorders. Even better is the Canopus NX card. For 100% stabilized jitter, another Panasonic Recorder of the older generation (eg DMR-
ES10) must be placed in front of the final digitizing HDMI DVD recorder or the Canopus NX card. (The procedure is described above) Each video
tape recording adds more or less noise to the video image. How strong this is depends on the format involved, the quality of the tape and the
recording and playback device. Even with recorded residual noise eg weak RF television signals is of course still present in the picture.To reduce
noise, there are countless editing algorithms, almost all composed of temporal filters. It is recommended not to filter out "too much" image noise,
but to leave the rest of the coding of the final video codec. The noise reduction can be done 100% in post-processing. Who shuns the effort by
software, can also connect a built-in DVD recorder noise filter, which also often already provides good services. (The setting is described above in
"DVD Recorder Configuration")

3. Color shift:

Since the brightness (the black-and-white image) and the color components are separately recorded and pre-treated on videotapes, there is almost
always a slight horizontal and vertical shift of the underlying SW image and the superimposed color. The amount of horizontal and vertical
displacement depends on the combination of recording and playback device. The originally recorded source signal may also already have shifts.
This effect is particularly strong in multiple copies, where videotapes were re-transferred to other videotapes. Here the errors add up. Visible are
color shifts on color edges with a high contrast change. The color shift can be corrected 100% by software in the post-processing. 4. Edges:
First and foremost, the "shimmering" edge at the bottom of the picture, which is more or less pronounced on all tape recordings, has to do with the
switching of the video heads. The phenomenon is completely normal. On televisions this was just not recognizable, as they have a so-called
"overscan area" and cut off from all sides a noticeable part of the picture. This lower area should be cropped or blackened in any case (if you want to
preserve the original size). 
Also on the other edges (top, left, right) are mostly unclean black edges to see. These in turn have nothing directly to do with the tape recording, but
already come from the original, original image source.
The margins, as well as any black letterbox bars, can be cropped at will in the postprocessing by software.

5. Too high white point:

It often happens when digitizing analogue tapes that white / bright image parts are slightly "overexposed". This is because the voltage levels of the
Y-luminance component may be slightly too high. For this there are "reserve values" in the digital YUV color space. In contrast to RGB, the value
"16" (instead of "0") represents black in YUV, and the value "235" (instead of "255") represents white. The values between 0 and 16, as well as
between 235 and 255 are still present, and represent a (not visible) "reserve". Now you can correct the contrast in the direction of black of the Y-
channel by up to 20 values, and thus bring supersaturated white values from the reserve into the visible range. What features does the recorded
raw AVI have, and what is there to consider?

a)

The recorded AVI video contains raw, uncompressed video data in UYVY 4: 2: 2 format, as well as a resolution of 720x576 pixels at 25fps (PAL)
[resp. 720x480 pixels at 29.97fps (NTSC)], and uncompressed PCM audio at 48kHz, 16-bit, stereo (standard for video). This video file still contains
all borders, the color shift the image noise (if not already filtered in the DVD recorder). b)

In most cases, we are dealing with interlaced material (ie, field-based). This is recognizable by horizontal "stripes" (scan lines) during movements.
This phenomenon also has nothing to do with the tape recording, but rather with the original source material. The field process is as old as television
technology and doubles the frame rate in moving areas at the expense of resolution, with full resolution available in low-motion and static image
areas. Even in modern HD television, this method is still partially applied.This "interlaced process" can be converted into post-processing either with
more or less complex procedures to form full images. Mostly it is the better idea to keep it! Every modern video codec (especially H.264) supports
the encoding of interlaced material. With a corresponding media player, this material is then displayed correctly on the PC, the Smart TV or mobile
devices. If purely progressive full-frame material (eg movies) has been dubbed, there are no scan lines. In this case, the material can be treated and
encoded as a "progressive" frame material. c)
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The pixel aspect ratio of the image is not 1: 1. This gives a slightly "compressed" width (PAL) [resp. Width-straightened (NTSC)] image at 4: 3
material. If it is anamorphic 16: 9 content (which is quite possible with analog video recordings, but rarely occurs in practice!), The distortion is
even stronger. That can be kept that way. When encoding the codec only the correct pixel aspect ratio (PAR) must be communicated. Then the
image is correctly equalized during playback. Common PAR ratios (divisor & decimal (3-digit rounded)):

4: 3 PAL (ITU): 1150/1053 (~ 1.092)
16: 9 PAL (ITU): 4600/3159 (~ 1.456)
4: 3 PAL (generic): 16/15 (~ 1.067)
16: 9 PAL (generic): 64/45 (~ 1,422)
4: 3 NTSC (ITU): 38800/42651 (~ 0.910)
16: 9 NTSC (ITU): 155200/127953 (~ 1,213)
4: 3 NTSC (generic): 8/9 (~ 0.889)
16: 9 NTSC (generic): 32/27 (~ 1,185)

For letterbox formats (black format bars), the PAR ratio of the "parent" format applies.

Margins and letterbox bars can be cropped at will - this will change the ABSOLUTE aspect ratio of the video - the PAR (pixel (!) Aspect ratio) will
ALWAYS be the same! The PAR ratio has nothing to do with the video tape format, but was defined by the source image source!

Rule of thumb:

Whether it's 4: 3 or 16: 9 formats, it's difficult to see with the naked eye - of course. Otherwise: Va old TV recordings (as you often find them on
VHS) are usually 4: 3 (or letterbox), and correspond to 99% of the ITU standard.This also applies to analogue and digital (!) Camcorders (V8, Hi8,
(S-) VHS-C, also DV and D8), from which recordings are read either directly or eg on VHS tapes was dubbed. With "more modern" TV recordings
on VHS, which were made by a DVB receiver, or with DVD movies recorded on video, I always assume a "generic" PAR. Since digital TV,
"generic" and ITU can no longer be distinguished and are often broadcast "mixed colors". Often you can only "guess" whether it is Generic-PAR or
ITU-PAR ...

The post-processing:

Since there are almost INFINITE software options for reworking and encoding the material, here is a brief * ONE * possible method presented,
how to proceed to create MP4 videos ... Required software (freeware):

Installation:

First, XMedia Recode and the UtVideo codec must be installed. This is done via normal setup routines, which will not be discussed here.

VirtualDub can be "unzipped" into any directory. This is possible with pack programs such as WinRAR or 7zip. Depending on the version of
Windows used, the x86 or x64 version can be loaded. It is recommended to place it in a newly created "VirtualDub" folder under "C: \ Program
Files" [32-bit version on 32-bit systems] or "C: \ Program Files (x86)" [32-bit Version on 64-bit systems] or "C: \ Program Files" [64-bit version on
64-bit systems] and create a desktop shortcut to "VirtualDub.exe". From the folder of the JPSDR filters, the correct * .vdf plugin file must be copied
to the plugin folder in the VirtualDub directory (plugins32 or plugins64). Depending on whether the x86 or x64 version of VirtualDub is used, you
must search for the "x86" or "x64" folder of the JPSDR filter archive and select the * .vdf file in the corresponding subfolder for the respective
processor / operating system will be copied to the plugins folder. Finished.

Configuration:

Now after the first start a few important settings have to be made in VirtualDub:

Video -> Color Depth: Set both "Decompression format" and "Output format" "4: 2: 2 YCbCr (YUY2)" (important!). Then click on "Save as
default" and then on "OK".
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Video -> Filters -> Add: Here, in addition to the internal filters and the JPSDR filter should appear.

First add the JPSDR filters 1. "Chroma Shift" and 2. "Add Border" one after the other. First confirm the configuration window with OK.

Now select the 1st filter "Chroma Shift" and open the settings under "Configure ..." on the right. Here, the horizontal and vertical shift can
now be entered for each of the two color components. Via "Show Preview" you can later search for a striking single image, and determine the
exact values (even if nothing is still visible here, since we have not yet opened a video). IMPORTANT: Only STRAIGHT NUMBERS may
be used! First of all we set "2 to the left" and "2 to the top" for each color component - this is usually a good starting point:
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Now select the filter "Add Border", and first right on "Cropping". The cropping
function always works BEFORE the respective filter! There, below "Y2 offset",
we cut 10 pixels away from the bottom edge (which is a good value for the head
switching range). Also here is nothing yet to be seen, since no video is open.

Then open the settings of the "Add Border" filter (Configure ...) and "hang down" 10 pixels of black pixels (bottom) again, and all color
values down to 0.

OPTIONAL: If the white point of the digitized video is too high (occurs more
frequently), and light spots are "overexposed", then finally add the filter "Sat /
Hue / Bright / Contr" (also part of the JPSDR filter):

[INDENT] 
In the configuration of the filter, by adjusting the value for "Contrast" (and ONLY this!)
With small negative values (about 0 to -12), the white point can be slightly adjusted
downwards (check in a bright spot by preview) ). It is important that ALL 3 hooks are
set to "Allow 0 to 255 ...", and under "0 to 255 Mode", "Input & Output" is necessarily
activated! 

[/ INDENT]

[INDENT] [/ INDENT]
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Now close the filter window with OK. We therefore retain the original format and margins for the beginning, covering only the lower
"flickering" area.

Video -> Compression: Here still "UtVideo YUV422 BT.601 VCM" as output codec is selected.

Under "Configure", a checkmark is set for "Same as # of logical processors", the selection for "Optimize for compression ratio (Predict
median)" is set. Please do NOT tick "Assume interlaced video", otherwise XMedia Recode will not be able to read the output video. (At 4: 2:
2-YUV, the interlaced flag does not matter).

Finally, all settings are saved as "template", this is done under "File -> Save
processing settings", eg under "VHS_Vorlage.vdscript".

Edit first video:

Open the raw AVI video with VirtualDub (either via "File -> Open video file", drag
and drop into the program window or the shortcut, or via "Open with" in Explorer.

Once VirtualDub has been closed, the saved settings must be reloaded via "File ->
Load processing settings"

Now under "Video -> Filters" adjust the values of the chroma shift filter by "Show
Preview" to match the video ("Configure ..." button).

Now the beginning and the end of the desired sequence have to be cut. This is done via the cropping function (Cut buttons) via the Scoll bar
below. The easiest way to navigate to the desired starting point, set the start marker, navigate to the end point and again sets a marker. Thus,
several parts can be cut out one behind the other and saved.

If border and color shift are adjusted correctly, the edited video can now be saved (File -> Save as AVI ...). The file is now already much
smaller, since the lossless UtVideo codec was selected. Nevertheless, the files are still huge, and now have to be encoded in a modern video
compression format such as H.264.

encoding:

Open XMedia Recode
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There you choose "Custom" as profile, and "MP4" as format. If you have ticked "Sync audio / video" check box if ticked (I'm not sure what it
does).

Now the edited video is loaded (either via "open file" or via drag & drop).

Under "Video" we recommend to change the following settings:

[INDENT] codec: "MPEG4 AVC / H.264" / bitrate mode: "Constant Quality" / Quality: [between 16 and 24 - depending on the material - gives very
useful results when the bitrate achieved is approximately between (as the case may be) 2, 5 and 8 Mbps. The ABR mode, where the average target
bit rate is set directly, may also be an option!] / Preset: "Slow" ["Medium" is also sufficient for slower CPUs] / Display mode: "Interlaced TFF" [or
"Progressive" - ONLY for film content without scan lines!]

TIP:

Depending on the source material, it may be very useful, especially when using higher bit rates (5 ~ 8 Mbps), to set the encoder under "Tune" to the
setting "Grain"! [/ INDENT] 

Under "Audio", the following settings are useful:

[INDENT] Codec: "MP3" / Sample Rate: "48000" / Bitrate Mode: "VBR New" / Minimum Bitrate: "192" / Maximum Bitrate: "256" / VBR Quality:
"VBR 2" / Quality: "High (Q = 2) " [/ INDENT] 
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[INDENT] UPDATE: In newer versions of XMedia Recode, the "Fraunhofer FDK" codec is now integrated as an AAC encoder. This is very useful
and comes as an alternative to MP3 (Lame) in question. The bit rate is ABR 160 ~ 256 kBit / s for HiFi stereo. MP3 is still just as much an option. 
[/ INDENT]

Under "Filter / Preview", the aspect ratio must now be set under "Video Size". Unfortunately, only the total aspect ratio (DAR) can be
specified in XMedia Recode, which is then recalculated "internally" back to the PAR. Since we have not changed the original format
(720x576), it is sufficient here to enter "4: 3" [or "16: 9" for anamorphic] - this then corresponds to the respective "Generic PAR". Anyone
who has trimmed to "crooked values" or wants to deposit another PAR (eg ITU) must set "user-defined" and calculate the DAR decimal value
from the SAR resolution and the desired PAR:

[INDENT] [Width Px] / [Height Px] * [PAR Factor] = [Target DAR]. [/ INDENT] 

Finally, click on "Add Job" and then on "Coding"

Now the final encoding starts! I wish you success!!

Naming the file names:

It is recommended that you name the clips correctly when caching the blanks from the raw
AVI in VirtualDub to avoid confusion. For me, the following naming patterns have been
proven: TV recordings: [yyyymmdd_hhmm] [Sender] - [

Shipment name ] .avi Example: "20160312_2015 ARD - Tatort.avi" Original Movies: [
Movie Name ] .avi

Example: "The Wolf tanzt.avi " Private Camera Shots: [yyyymmdd] [Event] .avi

Example:" 19990606 Birthday of Aunt Erna.avi "

Playback of the finished encoded videos:

Once the videos have been finally encoded and named, they can be conveniently stored on a NAS hard drive, downloaded to the Internet and played
back on PC, Smart TV, as well as on mobile devices (mobile phones, tablets).
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Smart TVs and BluRay / media players with USB input usually play the MP4 videos directly in the correct aspect ratio and evaluate the interlace
flag. On PCs and "smart devices" may have the correct player software installed ... Windows:
For the playback is recommended as the VLC media player. After installation in the settings under "Video" the deinterlacing still has to be globally
set to "Automatic", and as a method "Yadif 2x" is recommended.
Even the "Media Player Classic" with its extensive configuration settings is recommended.

 

Android:
Many pre-installed stock video players give the correct aspect ratio, but can not deinterlace. 
For Android, the "MX Player" is recommended as a good alternative.

Have fun and good luck !!!

Note: There is a GENERAL info thread with many technical backgrounds HERE: 
[Guide] Contemporary
High Quality Analog Capturing via USB or HDMI
------------------------ -------------------------------------------------- -
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https://gleitz.info/forum/index.php?thread/46713-Zeitgem%E4%DFes-hochwertiges-analoges-Capturing-per-USB-oder-HDMI
https://gleitz.info/forum/index.php?thread/46713-Zeitgem%E4%DFes-hochwertiges-analoges-Capturing-per-USB-oder-HDMI


Copyright notice:

I make no copyright claimson this tutorial. It may and should be recommended and linked!

Moderators / administrators are welcome to make useful additions and / or updates to links and program versions!

(If someone wants to do the work of translating the tutorial in English, they are welcome to do so!)
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